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This document helps you get started with Autodesk® Green 
Building Studio®  web service and presents the fundamental 
concepts of the product, including: 

• Defining Autodesk Green Building Studio 
• Why you should use Green Building Studio 
• Common pitfalls, and making the most of Green Building 

Studio energy analysis  
• How Green Building Studio works 
• Registration and installation 
• How to perform some common tasks in the product 
• Energy results and what they mean 
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Hints and Tips 

One of the most important 
energy decisions an architect 
makes is selecting a design 
scheme early in the design 
process. Yet a vast majority of 
architects do not know the 
energy and carbon impact of 
their choice while making it. 

 

Defining Autodesk Green Building Studio 
Sustainable design is more important than ever. Building information modeling (BIM) solutions make sustainable 
design practices easier by enabling architects and engineers to more accurately visualize, simulate, and analyze 
building performance early in the design process. The intelligent objects in the building information model enable the 
advanced functionality of the Autodesk Green Building Studio web service. 
Using Autodesk Green Building Studio, architects and designers can work 
toward carbon neutrality early in the design process. 

The Autodesk Green Building Studio web service helps provide rapid, 
accurate energy use estimates for your building design within the building 
information model. It enables collaborative design, allowing you to share 
building information with other team members, streamline or eliminate plan 
take-off tasks, and transfer essential information about your building design 
to the applications used for engineering design or code analysis.  

Welcome to whole building energy analysis! 

Why You Should Use Green Building Studio 
Good management of energy resources is fast becoming an essential factor in building design. Stakeholders want to 
know how the design will impact the environment, what lifecycle costs will arise from energy use, and if it is compliant 
with energy codes. The Autodesk Green Building Studio web service provides: 

• Annual energy cost 
• Lifecycle energy costs (30 year) 
• Annual energy consumption (electric and gas) 
• Peak electric energy demand (kW) 
• Lifecycle energy consumption (electric and gas) 
• Onsite energy generation from photovoltaic and wind systems 
• Water use analysis 
• Assistance with daylighting using glaze factor calculations 
• Natural ventilation potential calculations 
• Carbon emission calculations 

The Autodesk Green Building Studio web service is designed to work within the familiar environment of your own 
design software. You can iteratively model the shell of your building, ask for an energy analysis, revise the design, 
and ask for a comparative analysis—enabling you to interactively explore the energy cost implications of your 
decisions.  

It can also facilitate collaborative design, allowing you to share building information with other team members, 
streamline or eliminate plan take-off tasks, and transfer essential information on your building design to the 
applications used for engineering design or code analysis. The Autodesk Green Building Studio web service can help 
to change the way building energy analysis is used in the building design process. 



GREEN BUILDING STUDIO USER GUIDE 

 

Hints and Tips 

The Autodesk Green Building Studio 
web service is designed to be used 
during your scheme selection process 
to evaluate every scheme you are 
considering.  

Do not wait until you have made all 
your design decisions before using 
Green Building Studio as it is 
designed to provide you with the 
information to make informed 
decisions as they relate to energy. 

How the Autodesk Green Building Studio Web 
Service Works 
In a nutshell, the service provides a user-friendly front end to some of the world’s most powerful building energy 
analysis software. The calculations that lie behind this interface require a significant amount of information that is both 
time consuming to collect and likely unfamiliar to most building designers. All of the computationally intensive hourly 
simulations are carried out on remote servers, and the results are provided to you in a web browser. Autodesk Green 
Building Studio aims to save you time and energy by automating as much of this process as possible, which is why 
the service can be used interactively from the beginning of the design process. 

The analysis process will collect data from three sources: 

1. Your Revit® software model. All the building geometry comes from your model, including the number of 
rooms, the connections between rooms and their relationship to the exterior, exposure, and aspect to the 
sun; and the shape and total area of built surfaces or openings. Refer to the “Making the Most of Green 
Building Studio Energy Analysis” section for more information. 

2. Your responses to a few basic questions. In order to explain the building’s use or context, you will need 
to select a building type from a drop-down menu and enter the postal code for the site. You will also have a 
chance to select a weather station for the project, although the closest one is selected to be the default. 

3. Regionalized databases. Based on the above information, Autodesk Green Building Studio will extract 
additional information about local weather conditions, construction, and materials. The service will 
automatically add any information you have not provided, so it can seamlessly adapt to your requirements 
as your design evolves.  

Making the Most of Green Building Studio Energy 
Analysis 
This section describes the way you would ideally model a building and provides tips that can help you pinpoint 
problem areas.  

Model Your Building 
Energy analysis requires spatial information—it is essentially a simulation of 
energy movement in, out, and through the building. Which walls are 
exposed to the outside? How many are exposed to sunlight? What are the 
number, size, and orientation of openings? How much heat is generated by 
internal lighting and equipment? 

In the past, this information was manually calculated from 2D drawings. An 
engineer would use building plans, elevations, and details to collate spaces 
(type, area, volume), surfaces (including adjacency and thermal properties), 
and shading. All this information is latent in a Revit model, and in a form 
that is much easier to interpret than 2D drawings. And, if the project is 
consistently structured, software such as Green Building Studio can help take the pain out of the process. 

The net result is that a time-intensive task that might only be done once, very late in the design process, can 
realistically be repeated on demand innumerable times. This is a very important contribution to the design process at 
a stage when change is still possible. 
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There are some crucial things to note, however, and chief among them is how you go about modeling a building in 
your BIM tool. You must follow the crucial rules below if you are to get the most out of your BIM tool with Green 
Building Studio. 

Create a Revit model very early in your design process. A simple model allows you to compare forms 
and gross amounts of glazing, orientation, and shading. Green Building Studio only requires surfaces, 
openings, and rooms to simulate your building. For example, create a building form with approximately the 
right glass area on each façade, but do not worry about the details of window sizes. For schematic 
purposes, a continuous ribbon of glass that has the same area as a series of punched windows provides 
enough detail to make decisions about glass area. 

Do not use Revit software like a 2D CAD tool. This oversight generally occurs when users are looking for 
a set of construction documents (CDs)—floor plans and details. Consequently, floors, ceilings, roofs, sill 
heights, and so forth may not be modeled as they are not required in typical CDs. However, inclusion of 
these elements in your BIM model is crucial to the successful use of Green Building Studio. 

Model floors, ceilings, and roofs, in addition to walls and windows. These are essential items when it 
comes to whole building energy analysis. 

Model the windows and skylights that are possibilities. Glazed areas contribute the most to HVAC 
energy use. Do not worry about getting window and skylight sizes exactly right as Green Building Studio 
allows you to quickly resize or remove them by orientation. 

Model significant spaces only. Do not spend time modeling small spaces, storage spaces, phone closets, 
and so on that will increase simulation time and model complexity, but not increase accuracy of your results. 
Think of your building in the context of space uses and placement. For example, create “rooms” that are on 
the perimeter of the building (approximately 15-feet deep), add core “rooms,” and only partition the interior if 
the core becomes very large or is influenced by the nearby perimeter. 

Connect all walls, roofs, slabs, and ceilings. Be sure that your walls connect to each other as well as to 
their respective slabs, ceilings, and roofs. Do not leave gaps in your model. 

Registration 
Step One: The first step is to become a member of the Autodesk Green Building Studio web service. Go to 
greenbuildingstudio.com/default.aspx, click on the New User Registration link, and fill out the necessary information. 
Once you have agreed to the Terms of Use, an email will be sent to you to validate your email address. This is to be 
certain your email address is entered correctly.  

Step Two: Once you receive the email, either click the button in the email or copy the URL in it to your browser’s 
address bar. Both of these actions will return you to Green Building Studio software, at which point you just need to 
log in using the User Name and Password provided in the email. You are now a member of the Green Building Studio 
web service. 

Note: It is possible that your validation email might be filtered by your domain administrator and routed to your Spam 
or Junk folder. If you do not receive your validation email within an hour, contact the Autodesk Green Building Studio 
team for assistance at support.gbs@autodesk.com.  
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Installation Guide for Green Building Studio Client 
To run Autodesk Green Building Studio from within Autodesk® Revit Architecture software or Revit® MEP software, 
you will need to use the Green Building Studio Plug-in. It submits the green building XML (gbXML), files created by 
the Revit software to the Autodesk Green Building Studio web service.  

Step 1: Download the zip 
file containing the Green 
Building Studio Plug-in 
from the Green Building 
Studio download page as 
seen at left. 

 

Step 2: Unzip the file seen in the image below to a temporary directory and double-click the setup.exe file. 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Once installed you will find the Green Building Studio Plug-in under the menu Tools>External Tools>Green 
Building Studio Client, which can be accessed from any plan view. 

 

 

 

 

After you have registered for Green Building Studio, you are ready to create new projects, make changes to your 
design in your Revit Architecture 2009 or Revit MEP 2009 software model, and analyze the performance of your 
design. 
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Hints and Tips 

The choice you make for Building 
Type and Schedule can have a 
significant impact on your results. For 
example, if you are modeling a 
mixed-use building and choose 
Retail, the analysis will assume 
higher interior lighting loads than if 
you choose Office. Furthermore, the 
default schedules vary by building 
type. A retail store by default is 
assumed to be open more hours per 
year than an office building and 
hence will use more energy. 

Creating New Projects 
Once you log in you will be on the Project List page, and you are ready to add your first project. Just click the New 
Project link on the top left of the project list. 

 

You must enter the Project Name and select a Building Type from the list of 
approximately 30 typologies and a unique building schedule, which is optional. 
There are two types of projects: Demonstration or Actual Building Design. Select 
Demonstration if you are sampling or a trial user of the service.
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Green Building Studio incorporates Google™ Maps to facilitate entry of a new project and select the appropriate 
weather file. Enter your project’s address or the city and state or postal code in the Location text box, and click on the 
Find Location button. Move your green building icon to relocate. When satisfied with the selected location, check the 
checkbox below the map, and select the Next button. 
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The next New Project screen will display all the weather files that the 
Autodesk Green Building Studio web service has in the vicinity of your 
project. Through this screen you can explore each weather file’s degree 
day and design day characteristics and select the appropriate one, though 
by default the station closest to the building is selected. 

Autodesk Green Building Studio Stations are based on recent “actual 
year” weather data rather than TMY2 and CZ2 stations, which are based 
on 30-year averages of weather data. 

Simply select the radio button to the right of the map to select the desired 
weather file, and click the Next button. 

 

  

Hints and Tips 

C Design and H Design are the outdoor 
cooling and heating design temperatures 
typically used to size heating and cooling 
equipment. HDD and CDD are the 
heating and cooling degree day totals for 
the weather location you have chosen. 
Compare the design and CDD/HDD data 
for the available weather files to 
determine which weather file most 
closely approximates the weather for 
your site. 
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Hints and Tips 

Your local utility may have its 
current rates posted on its website. 
In some cases, natural gas is 
priced per unit volume. If gas is 
priced per cubic foot, multiply the 
price per cubic foot by 100 to get 
the approximate price per therm.   

1 therm = 100,000 Btu.   

The price of natural gas can vary 
widely by season. Use the price of 
gas that is typical during the 
heating season if most of your gas 
use is for space heating. 

The next screen is where you specify additional address information as well as utility cost information. Make sure a 
postal code is entered, and click the Get Utility Cost button to retrieve the Autodesk Green Building Studio electric 
and fuel cost defaults. These are based on the previous year’s state average prices for fuel and electricity that are 
published by the U.S. Department of Energy. Modify them if you have more relevant data. 
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Autodesk Green Building Studio software enables you to share information about your project with design team 
members and Green Building Studio partners who may provide more information on how their products can fit with 
your building design. To ensure you are authorized to share project information, Green Building Studio needs to know 
who has authorized you to share project data if you are not the owner of the building information you are submitting. 
The authorizing agent you specify will also receive a copy of the Autodesk Green Building Studio Terms of Use 
(TOU).  
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Finally, for new projects you need to specify the budget, current design phase, the estimated construction start date, 
and if the project has a green building goal.   

 

After you create a new project you will receive an email containing the TOU specific to this project for your records. 
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Revit BIM Model Development 
The Autodesk Green Building Studio web service is designed to be used during the scheme selection process to 
ensure resource use information relating to energy, water, and other metrics is available and used during the scheme 
selection process. With this in mind, we recommend you keep 
your model as simple as possible. We recommend you only 
model major spaces and combine smaller spaces that 
represent key programmatic requirements of the project. Do 
not include all interior partitions that will eventually be part of 
the final building. 

Adding more interior partitions than is required will create more 
work in the model, introduce potential errors, and slow the 
simulation without significantly improving the accuracy of the 
results 

If you are familiar with a thermal zone layout of a building, we 
recommend your room layout be similar. Perimeter rooms 
facing the same direction should be grouped together. Core 
zones with little or no exterior exposure should be grouped 
together.  

Similarly, unconditioned support spaces, such as restrooms, 
stairwells, elevator shafts, and storage spaces, should be 
grouped together. Work with your mechanical engineer for 
guidance on such a layout if you are not familiar with it.  

 

 

 

 

 

 

  

Too Much  Correct Level 
Detail                           of Detail 
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Hints and Tips 

Room objects will be placed at the level on 
which you are working on. By default the 
upper limit and the level will be the same. 
Default room height is captured using the 
Limit Offset and is typically 8 feet.   

Take advantage of the Revit Architecture 
parametric capabilities, and use the level 
above your current level as the upper limit 
rather than relying on the limit offset. If 
levels are later changed, the room height 
will be automatically adjusted, and you will 
not have to individually modify each room’s 
height.     

Revit Architecture 2009 Room Object1 
Your Revit® Architecture software model must have Room objects defined for all rooms or group of rooms that you 
want to be exported to gbXML and analyzed by the Autodesk Green Building Studio web service. You must ensure 
that the Room object is positioned properly in the model and that the room is high enough to “touch” a bounding 
surface. In the next few pages we will describe how to ensure the Room object is being used correctly. 

Adding Revit Room Objects  
Revit Architecture allows you to add Room objects to your model at any time. It is fairly easy, but a new concept for 
most regular users of CAD.  

• Open a plan view of the level you want to add rooms. 

• Select the Room object from the Basics tab or the Room and Area tab. 

• Click in the center area of the model area where you would like a room to be defined. 
Revit Architecture then highlights all the bounding walls that make up the room 
boundaries for the newly added room. 

• All rooms should be in the New Construction phase. Choose Phases... under the Settings 
menu, and then combine all phases into New Construction. 

 
  

                                                           

 

 

 

 

 
1 If you are using Revit® MEP 2009 software, please skip ahead to the section named “Revit MEP Space and HVAC 
Zone Objects.” 



GREEN BUILDING STUDIO USER GUIDE 

 

Checking Room Object Height 
The best way to view a Revit Architecture room object’s height is viewing it in section. First you have to ensure the 
Visibility of the room object’s Interior Fill is selected. You can access the Visibility/Graphic Overrides dialog box using 
the View>Visibility/Graphics menu. 

Figure 1─Revit Visibility/Graphic Dialog 

Once you have enabled the Interior Fill for Rooms to be visible, you will see the room object in section view. 
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Figure 2—Revit Section View: Height of Room Objects Incorrectly Defined 

If your room object is not touching the entire roof or ceiling in the room, then not all of that roof or ceiling will be 
exported to the gbXML file. By default, the room height is 8-feet above the base level. The file will still run, but will not 
be thermally correct. Figure 2 above illustrates room objects on the lower floor that are incorrect because they are not 
in contact with the ceiling.  

The room objects on the second floor are incorrect because they are not in contact with the roof. Walls, roofs, 
columns, curtain systems, building pads, and room separator lines can be made to be room bounding objects by 
changing element properties. Floors and ceilings are always room bounding.   

The way to fix these types of issues is to select the Room object by right-clicking the X over the Room object when it 
appears and selecting the Properties menu item, as seen below. 
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In the properties window for the room, change the Upper Limit to the level of the roof or ceiling and add a Limit Offset, 
if necessary, to increase the room object height to enclose the entire roof. Then go back to the section view to 
confirm the roof or ceiling is now fully enclosed in the room object. Figure 3 below illustrates the room object now 
correctly defined. The rooms on the lower floor are now in contact with the ceiling and the rooms on the upper floor 
are fully in contact with the roof. Although the upper-floor rooms graphically extend above some of the roof surfaces, 
the room volumes will still be computed correctly. 

  

Figure 3—Revit Section View: Height of Room Objects Correctly Defined 

 

Changing the Height of Multiple Room Objects  
The best way to change multiple room heights is to select them all on a floor plan. In the Floor Plan view, select all 
items on that floor by clicking and dragging the selection box over the entire floor or area of desired rooms. Click the 
Filter  button on the toolbar as seen at left. Then uncheck all items except the Rooms on the Filter dialog. 

At this point, all rooms from your 
selection will be selected. Right-click 
on a selected room object and select 
Properties from the menu. Set the 
Upper Limit and Limit Offset to the 
desired values. 

You can also change the height of 
several room objects by creating a Room Schedule that 
includes the Room Name, Level, Upper Limit, and Limit 
Offset. Then edit the Upper Limit and the Limit Offset in the 
Room Schedule as needed. 
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Hints and Tips 

Only surfaces in contact with the 
space object will be exported to 
gbXML. 

 

 

Revit MEP 2009 Space and HVAC Zone Objects2 
Unlike Revit Architecture 2009, Revit® MEP 2009 software does not require the definition 
of rooms for successful analysis by Autodesk Green Building Studio; however, Revit MEP 
models must have Space and HVAC Zone objects defined.  

You must manually add space objects within your project. By default, Revit MEP will 
automatically create one HVAC Zone for the entire building and assign all of your spaces 
to that HVAC Zone. You must manually create additional HVAC Zones if appropriate for 
your project.  

When exported to Green Building Studio, the gbXML file automatically groups multiple 
spaces assigned to one HVAC Zone into one space (this is due to the limitations of the 
DOE-2.2 simulation engine used by Green Building Studio). This may not be problematic 
for your project unless you have a mixture of conditioned and unconditioned spaces 
grouped together under one HVAC Zone. The Green Building Studio analysis will be 
unable to properly analyze mixed conditioning types within one HVAC Zone. In order to 
retain the proper condition type (conditioned, unconditioned, and so on) for your spaces, 
you must assign spaces of similar condition type to each HVAC Zone within Revit MEP 
2009. This topic will be covered in more detail in the section below called “Adding Revit 
MEP 2009 HVAC Zone Objects.” 

Adding Revit MEP 2009 Space Objects 
After adding the space object, you must ensure that it is positioned properly in 
the model for the best results. Over the next few pages we will describe how 
to ensure the space object is being used properly. The process for defining 
space objects in Revit MEP is very similar to the process for defining room 
objects in Revit Architecture. 

1. Open a plan view of the level you want to add spaces. 
2. Select the space object from the Mechanical tab. 
3. Click in the center area of the model area where you would like a space 

to be defined.  

Revit MEP should then highlight all the bounding walls that make up the space boundaries 
for the space you just added.  

                                                           

 

 

 

 

 
2 This section only applies to Revit MEP 2009. If you are using an earlier version of Revit 
MEP or any version of Revit Architecture, please review the section named “Revit 
Architecture 2009 Room Objects.” 
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Checking Space Object Height 
The best way to view a Revit MEP space object’s height is to view it in section. First you 
have to ensure the Visibility of the space object’s Interior Fill is selected. You can access 
the Visibility/Graphic Overrides dialog box using the View/Visibility>Graphics menu. 

 

 

Figure 4—Revit MEP Visibility/Graphic Dialog 
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Once you have enabled the Interior Fill for spaces to be visible, you will see the space 
object in section view. 

 

 

Figure 5—Revit MEP 2009 Section View: Height of Space Objects Incorrectly Defined 

If your space object is not touching the entire roof or ceiling in the room, then not all of that 
roof or ceiling will be exported to the gbXML file. Figure 5 above illustrates that the space 
objects on the lower floor are incorrect because 
they are not in contact with the ceiling. The space 
objects on the second floor are incorrect because 
they are not in contact with the roof. 

Walls, roofs, columns, curtain systems, building 
pads, and room separator lines can be made to be 
room bounding objects by changing element 
properties. Floors and ceilings are always room 
bounding.   

To fix these types of issues, select the space object 
by right-clicking the X over the space object when it 
appears, and then select the Properties menu item, 
as seen here. 
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In the Element Properties window for the space object, change the Upper Limit to the level 
of the roof or ceiling and add a Limit Offset that will increase the space object height to 
enclose the entire roof. Then go back to the section view to confirm the roof or ceiling is 
now fully enclosed in the space object. Figure 6 below illustrates the space objects now 
correctly defined. The spaces on the lower floor are now in contact with the ceiling and the 
spaces on the upper floor are fully in contact with the roof. Although the upper-floor 
spaces graphically extend above some of the roof surfaces, the space volumes will still be 
computed correctly. 

 

  

Figure 6—Revit MEP 2009 Section View: Height of Space Objects Correctly Defined 

Changing the Height of Multiple Space Objects  
The best way to change the height of multiple spaces simultaneously is to select them all 
on a floor plan. In the Floor Plan view, 
select all items on that floor by clicking and 
dragging the selection box over the entire 
floor or area of desired rooms. Click the 
Filter  button on the tool bar as seen at 
right. Then uncheck all items except 
Spaces on the Filter dialog. 

At this point all spaces from your selection 
will be selected. Right-click on a selected 
space object, and select Properties from 
the menu. Set the Upper Limit and Limit 
Offset to the desired values. That’s it. 
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You can also change the height of several space objects by creating a Space Schedule 
that includes the Space Name, Level, Upper Limit, and Limit Offset. Then edit the Upper 
Limit and the Limit Offset in the Space Schedule as needed (see below). 

 

Adding Revit MEP 2009 HVAC Zone Objects 
Revit MEP 2009 software automatically creates one HVAC Zone for the entire project and 
names it Default. You can verify this by creating an HVAC Zone Schedule (see below). 
The Level category is blank in this example because the Default HVAC Zone 
encompasses all the spaces on multiple levels of this project. 

 

In order to verify which spaces are associated with which HVAC Zones 

1. Select the Mechanical Tab 
2. At the very bottom, click on System Browser 
3. Right‐click on the System Browser window (on the right side of your 

screen) 
4. Choose View 
5. Select Zones  

In the example below, you can see that there are 18 spaces within the Default HVAC 
Zone. You may export your file to the Autodesk Green Building Studio web server at this 
point; however, the gbXML file will group multiple spaces assigned to each HVAC Zone 
into one space (this is due to the limitations of the DOE-2.2 simulation engine used by 
Green Building Studio).  



HEADER IS DOCUMENT TITLE 

23 

The Green Building Studio simulation will run if your project consists of only conditioned 
spaces grouped together under one HVAC Zone. However, it is usually not reasonable to 
combine all the spaces in a building into one thermal HVAC zone and will typically cause 
inaccurate results. If your project contains a combination of conditioned and unconditioned 
zones, and in order to retain the proper conditioning type of your spaces for the Green 
Building Studio analysis, you will need to group conditioned spaces together in 
conditioned space zones, and unconditioned spaces together in unconditioned space 
zones.   
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Hints and Tips 

Your HVAC Zone name must 
not contain any spaces within 
the text or the Green Building 
Studio run will fail. For 
example, the name “Zone 1” 
will cause the Green Building 
Studio run to fail, but the name 
“Zone1” will run successfully. 

Assigning Revit MEP 2009 Spaces to HVAC Zone Objects 
To create an HVAC Zone, go to the Mechanical tab and choose Zone. A small 
Zone window will appear with three icons plus Finish and Cancel buttons. In the 
example below, the HVAC Zone has automatically been named 2. To add a 
space to the HVAC Zone 2, move your cursor over the appropriate space, left-
click, then click on the Finish button. To add multiple spaces to one HVAC 
Zone, continue clicking on the desired spaces before clicking on the Finish 
button. Revit MEP 2009 will automatically name your new HVAC Zones 
beginning with the numeral 1.  

If you choose to rename the HVAC Zones, you can do so by creating an HVAC 
Zone Schedule and editing the HVAC Zone name within the Schedule.  
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Exporting to Green Building Studio 
from Revit Line of Products 
 
Step 1: Under the Room and Area Design Bar, 
select the Settings… icon to open the Room and 
Area Settings dialog box. Check the Compute room 
volumes check box. 
 
Step 2: Specify a zip code for your building’s 
location and the Building Type under the 
Setting>Project Information… menu and 
gbXML Settings parameter. 
 
 
 
 
Step 3: Select the Green Building Studio 
Client menu item under the Tools>External Tools menu. 
 
Step 4: Enter your Green Building Studio Username and Password and click the 
Login button. You must be connected to the Internet for this to work. 

Step 5: If you have projects in your Green Building Studio 
account, they will be listed in the Project list. Simply select the 
project to which this model is assigned. 

Step 6: Click on Get Results for Above File to initiate the 
simulations and get results. 
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Green Building Studio software will first check your Revit model for missing data or errors, 
and if problems are found, an error message will appear. Assuming there are no errors, a 
browser window will open similar to the one below presenting you with the status of your 
Green Building Studio whole building energy and carbon analysis. 

The length of time it takes to run the Green Building Studio simulations typically varies 
from less than a minute to 5 or 10 minutes. The run time depends on the server traffic, 
complexity of the mode, and the number of surfaces, windows, rooms, spaces, and zones. 
Typical schematic models will run in less than a minute. Most runs are complete within 
minutes. Very large models (with gbXML files more than 8 to 12 MB) may take up to an 
hour to run. This is another reason to simplify your model if possible, especially when a 
project is in the early stages of design.   

Once your run is complete you will see a screen similar to the one below. 
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Analysis Results  
The Green Building Studio results pages provide accurate yet easy-to-understand 
summary information on building energy and resource use, carbon emissions, simulation 
assumptions, performance metrics, and costs that can be used immediately to compare 
the energy costs of multiple building design scenarios at the conceptual design stage. The 
following discussion serves as a guide to interpreting the results effectively. Screenshots 
from various parts of the page are used to illustrate the results. 

Energy and Carbon Results 
General Information: The general information 
section at the top of the page describes the 
project scenario, building type, geographic 
location, and gross floor area. 

Estimated Energy and Cost Summary: Most 
building energy cost comparisons and early 
compliance decisions can be made using 
annualized energy cost and consumption 
information. Costs are estimated using statewide 
average utility rates, or the customized rates you 
may have applied to the project.   

The following information is provided: 

• Annual energy cost. 

• Lifecycle energy costs (30 year). 

• Annual energy consumption 
(electric and gas). 

• Peak electric demand (kW). 

• Lifecycle energy consumption 
(electric and gas). 

• CO2 emissions are based on the 
onsite fuel use and the fuel sources 
for the electricity in the region. 

• An equivalency using an SUV 
(driven 15,000 miles/year) is given 
to put the building’s CO2 emissions 
into perspective. 

Energy End-Use Charts: Further breakdowns 
of energy use for major electric and gas end 
uses such as lighting, HVAC, and space heating 
are provided in graphical format. Additional 
details associated with each category can be 
seen by clicking on the pie charts. 
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In addition to energy use and cost, 
Green Building Studio software 
provides additional information 
required to design a carbon neutral 
building. This additional information 
includes the following:    

Carbon Neutral Potential: This 
section will summarize the CO2 
emissions for your building design and 
identify the options to reduce them. If 
your net CO2 emissions are less than 
zero, there is a high potential for this 
building to be carbon neutral. 

Electric Power Plant Sources: The 
U.S. Environmental Protection Agency 
has historical records for all the fuel 
and emissions of all power plants in 
the United States. This section 
summarizes the fuel sources for 
electricity generated in this region. In 
order for a project to be carbon 
neutral, electricity consumption must 
be reduced or offset using renewables 
by an amount equal to the portion of 
the electricity that comes from fossil 
fuels.   

Water Usage and Cost: A summary is given of the estimated water use in the building 
based on the number of people in the building as well as the building type. Note that the 
water consumption is not related to the number of fixtures. 

Photovoltaic Potential: Green Building Studio software automatically analyzes every 
exterior surface of the building, including roofs, walls, and windows, for their potential to 
generate electricity using photovoltaics. Exterior shades are not currently included in the 
photovoltaic analysis. The results of this analysis are summarized in this section. Note 
that this analysis assumes that PVs can be installed on vertical as well as horizontal 
surfaces as long as the surface generates significant amounts of PV power. See the PV 
tab for details on the surfaces that are analyzed.   
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LEED Glazing Score: The LEED glazing score is the percentage of regularly occupied 
floor area that has a Glazing Factor greater than 0.02. Note that the tool assumes the 
entire floor area of your project to be regularly occupied unless you have defined some 
spaces through Revit MEP as restrooms, corridors, storage, mechanical rooms, or 
conference rooms (spaces not considered to be regularly occupied by LEED). The score 
must be more than 75 percent to score LEED points and achieve full benefit from 
daylighting controls throughout the building. 

Wind Energy 
Potential: The 
annual amount of 
electricity that can 
be generated 
from one 15-foot-
diameter wind 
turbine of 
conventional 
design.   

Natural 
Ventilation 
Potential: The 
tool calculates the 
annual operating 
hours and energy 
required to mechanically cool and ventilate the building. It also estimates the annual 
number of hours that outdoor air could be used to naturally ventilate the building. Potential 
energy savings associated with not running the mechanical cooling and ventilation system 
during this period are projected, and finally, the net hours that cooling is required, even 
with natural ventilation, are estimated.  

Building Summary: Detailed 
statistics, assumptions, and 
information on building constructions 
are also provided. This information 
allows the building designer to get an 
early assessment of code compliance 
and rough estimates of equipment 
sizing requirements for heating, 
cooling, and water heating, as well as 
window, wall, and floor area 
breakdowns. 
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Export Files and Navigation Links from the Results 
Screen 
Autodesk Green Building Studio software provides the user with file download capabilities 
that can be used to share information with other members of the design team who are 
performing detailed engineering analyses, such as equipment sizing or 
design. The user simply clicks on the links to access these items to download 
or navigate. Each file or link is described below.   

Export Files 
gbXML File: This link is to the fully populated gbXML file that contains all the 
building information necessary for an advanced energy simulation as well as 
the results from the Autodesk Green Building Studio simulation. The gbXML 
file also includes information on the BIM model and the local assumptions 
and building code information brought in through Green Building Studio. This 
file can be used with design tools such as Trane’s Trace 700 application. 

VRML File: Click this link to open the 3D VRML view in a new window or 
right-click it and choose Save Target As… to download the file. See the 3D 
VRML View section below for more information. 

DOE-2 File: This link exports the geometrically accurate DOE-2.2 input file 
that was generated by Green Building Studio for the energy simulation. It can 
be used downstream as the starting point for other more detailed engineering analysis. 
This file can be directly imported into the free eQUEST DOE-2 application at 
www.doe2.com.   

EnergyPlus File: This link exports the geometrically accurate EnergyPlus™ file that was 
generated by Green Building Studio. It can be used as a starting point for more detailed 
engineering analyses. The EnergyPlus simulation program can be downloaded for free* at 
www.energyplus.gov.  

Weather File (Binary and CSV): The DOE-2 binary weather file used in the simulation 
can be downloaded for further analysis off-line using eQUEST. The comma separated 
values (CSV) file can also be downloaded for use in other applications as well as 
conversion to other simulation engine weather formats such as EnergyPlus. 

Navigation Links 
Run List Link: This link returns you to the list of runs for this project. 

Design Alternatives Link: This link will take you to the design alternative screen where 
you can change design assumptions for this run and determine the impact of those 
changes. See the next section for details on the Design Alternative feature of Green 
Building Studio. 

Notes Link: If you want to make or view comments about this run, click here. 
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Navigation Tabs  
At the top of each results page are navigation tabs that allow the user to view additional 
information about their building design. These tabs are discussed on the following pages. 

 

U.S. EPA ENERGY STAR: This tab will display the ENERGY STAR score and associated 
data that can be used to benchmark the building design total energy use performance 
relative to the U.S. EPA’s ENERGY STAR requirements. Buildings that receive an 
ENERGY STAR score above 75 qualify for “Designed to earn the ENERGY STAR” and 
recognition from the EPA. 

Water Usage: The water usage tab allows the user to apply a variety of water saving 
measures, including efficient fixtures, water catchments, native vegetation, and others. It 
also summarizes the potential LEED points available for these measures.  

PV Analysis: The details of the photovoltaic (PV) potential analysis are listed in this tab 
showing the individual PV potential for every exterior surface in the building. Price per watt 
for the PV system can be made on this tab to account for rebates or other regional 
differences that affect PV system cost. See the VRML view tab to determine the building 
surface associated with each result. 

LEED Glazing: This tab lists all the spaces in the building and their individual Glaze 
Factor value. This data can be used to determine what spaces in the building could qualify 
for LEED daylighting credits.   

Weather: This tab contains a variety of weather data graphs and charts. These graphs 
can also be set for specific data types over specific periods of time.  
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3D VRML View: The 3D VRML View tab allows the building designer to review the gbXML 
geometry data in 3D, and rotate it to review the placement of walls, windows, floors, and 
other spaces. It requires a VRML Viewer program that is available for free* in the public 
domain, such as the free Cortona VRML client at www.parallelgraphics.com for Windows® 
operating systems and the FreeWRL VRML/X3D Viewer at www.apple.com for Mac® 
operating systems to view these files. Click on the surfaces in the list at the right of the 
window to identify them. When selected, a surface will highlight in red in the 3D view, and 
its surface type will be displayed at the bottom of the window.   
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Design Alternatives 
The Green Building Studio Design Alternative (DA) feature allows you to 
modify the base case assumptions and simulate the impact of these 
modifications on energy efficiency. It is a very powerful feature that allows 
significant design decisions to be made in very little time. 

The Green Building Studio Design Alternative feature can be accessed from 
the main “Energy and Carbon” results page link as described in the previous 
section or on the Run List page blue icon adjacent to the Run title as seen in 
the image to the left. The green icon can be used to see run values relative 
to the selected run. 

For every project in your list, three 
icons are available to access 
additional information. The first blue 
icon lets you customize project 
defaults such as internal gains, 
construction materials, glazing type, cooling and heating set points, and so on. This can 
be useful when using Green Building Studio software to analyze an existing building that 
has less efficient systems or less insulation, or if the default values do not represent your 
project. The second blue icon allows you to view and edit project information. The third 
icon facilitates managing project team members. You can invite other members of your 
design team to participate in the analysis, and you can individually assign them rights to 
the project (Read-Only, Download and Read-Only, Add Runs or Manager).  

Clicking on either the Energy and Carbon results page Design Alternative link or the Run 
List page DA link will take you to the Design Alternative page shown below. The top 
portion of the table has standard links to the Run List, the results page for the base run 
associated with these Design Alternatives. The section directly below lists the values for 
all the parameters that have been modified for the currently modified design alternative or 
the design alternative selected by the user. 
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Hints and Tips 

If your model is large and complex it 
will take longer to run. Try submitting 
design alternatives individually as 
they are defined. While that 
alternative is running, define and 
submit additional design alternatives. 

 

Adding Design Alternatives 

To add a design alternative, go to the Design Alternative screen associated with the run 
(shown on the previous page). Begin making the modifications you would like to analyze 
by selecting a tab and choosing the drop-down list value you would like to be applied for 
this alternative. Enter an Alternative name, and then click the Add Alternative button. 
Continue doing this until all the desired Design Alternatives are added.   

At this point you can select the Run Added Alternatives button to place the DAs in the run 
queue. Depending on the model complexity, server load, and the number of alternatives 
you are analyzing, it will take between a few minutes and an hour to complete your runs. 
Users can also add and run alternatives individually as they are defined or as described 
above, add a group of alternatives and run the group at one time.  

Once all the DAs are run, you can review their results either on the DA web page or the 
Run List page.  
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The VRML Model 

One of the download formats available on the Green Building Studio results web page is a 
VRML file (see example above, left). This is a 3D model that shows what the gbXML 
export has extracted from your project. Viewing the VRML file is a useful way of 
establishing that your simulation is an accurate representation of the whole building. 
Rooms or surfaces that are missing or that have been incorrectly identified (for example, a 
roof shown as a shading surface) will be apparent in this model. In the VRML example, 
the black edges along the roof have been exported to Green Building Studio as shading 
surfaces and not roof surfaces. The image above right is an example of a DOE-2 file 
opened in eQUEST. Notice there are several shades on the roof—this is because the 
upper limit of the room objects on the top floor is not high enough to contact the roof. To 
solve this, extend the room object’s top surface to above the roof’s top surface. 
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Tips 
• At the earliest “massing” stages of design, define glazing areas in the 

Revit model as “ribbons” of glass around the building, rather than 
individual punched windows. This is easier to model in Revit 
Architecture or Revit MEP, will reduce the simulation time in Green 
Building Studio, and will provide enough accuracy to analyze the energy 
impact of different glazing schemes. 

• If the gbXML file produces a message stating that horizontal surfaces 
are missing, it is likely caused by room objects not being in contact with 
the surfaces above 
them.  Adjust room 
or space objects 
accordingly. See 
the message below 
and the Revit 
Architecture 2009 
Room Object 
section for further 
details. 

• While using Revit 
Architecture, plenums and other interstitial areas should have a room 
object placed in them for them to be properly exported to gbXML. Any 
room or space less than 2‐meters high is assumed to be unconditioned. 

• If the DOE‐2 file is opened in eQUEST and 
there are several shades on the roof, it is 
because the upper limit of the room objects 
on the top floor is not high enough to contact 
the roof. To solve this, extend the room 
object’s top surface to above the roof’s top 
surface (as shown on the right) 

• Design Alternatives drop‐down list rollover 
information may not be fully visible. Highlight 
the text surrounding the drop‐down lists, copy 
and paste to a text editor or spreadsheet to 
view.  

• Enhanced 3D VRML View legend may not be 
fully visible. View the page on a screen size greater than 1,024 by 768, 
or open the VRML File link on the left sidebar. 
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*Free products are subject to the terms and condition of the end-user license agreement that 
accompanies the download of that free software. 
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